Dear Customer,

We thank you for choosing NETZSCH to serve your thermal analysis needs.

NETZSCH continues to develop both instruments and software, striving for further improvement. Many of your ideas, requests, and suggestions directly influence the direction of our developmental work.

Naturally, we want to inform you of hardware and software changes as they occur. Unfortunately, this is not always possible with printed documentation and we ask you to refer to the Help section of your software for up-to-date supplements, extensions, and changes.

The Help section also offers you the possibility of printing out the latest software extensions for your reference.

With best regards,

NETZSCH
Gerätebau GmbH
Contents

1 General Information Regarding Software Installation ........................................... 1
   Installation requirements .................................................................................. 1
   New installation ............................................................................................... 1
   Update ............................................................................................................ 1
   Modification .................................................................................................... 2
   Removal of Software ....................................................................................... 2
   Starting the “ServiceTools” program ............................................................... 4
   Uninstalling the USB-COM driver for F1/F3 instruments .................................. 8

2 New Installation/Update: From CD-ROM ............................................................. 10
   The NETZSCH Proteus® installer ................................................................. 10
   Generic / base software installation ............................................................. 14
   Instrument-specific unlock ........................................................................... 17
   Installation of demo-data files ...................................................................... 20
   Installation of the calibration files ............................................................... 27
   Finishing the installation .............................................................................. 28
   Going online for the first time with the measurement software ...................... 31

3 PDF Documents in the Measurement Software .................................................. 34

4 Automatic Installation of a PDF Printer ............................................................. 35

5 Installation of PCI and Other Components ......................................................... 36
   Installation of the PCI-IEEE488 card (only under Windows XP Prof.) .............. 36
   Installation of the USB-IEEE converter for connection to USB port of the PC (under Windows XP Professional) ................................................................. 39
   Installation conditions ............................................................................... 39
   Installation of the USB-IEEE converter for connection to USB port of the PC (under Windows 7 Professional 32/64-bit) .................................................. 42
   Some notes on how to use the USB-IEEE converter ..................................... 44
   Troubleshooting KUSB 488-Driver ............................................................. 45
   KUSB 488-Driver uninstallation .................................................................. 45
   Installation of the USB-COM converter for F1/F3 instruments and DIL 402 PC with USB interface (under Windows 7 Prof. 32/64-bit/ Windows 7 Enterprise 32/64-bit/ Windows 7 Ultimate 32/64-bit) ................................................................. 47

6 Customize the Installation .................................................................................. 48

7 Upgrade to NETZSCH TA Proteus® Software .................................................... 57
   Upgrade of DMA 242 16-bit to Proteus® 6.x .............................................. 58
   Upgrade of NETZSCH DSC200, TG209 16-bit 2nd generation to Proteus® 6.x ... 58
   Upgrade of NETZSCH series 200/400 16-bit 3rd generation to Proteus® 6.x .... 58
   Upgrade of NETZSCH series 200/400 4th / 5th generation to Proteus® 6.x ...... 58
   Upgrade of DOS to Proteus® 6.x ............................................................... 58

8 USB-COM Driver Update for the Instruments of the F1/F3 Series and DIL402PC ....................................................................................................................... 59
9 SystemFlasher .......................................................................................... 60
   Start of the SystemFlasher ........................................................................ 60
   In case of error messages ........................................................................ 62
10 Power Management .................................................................................. 63
   What is Power Management? .................................................................... 63
   Why deactivate Power Management? ....................................................... 63
   What does NETZSCH-Gerätebau recommend? ........................................ 63
   How can the Power Management be deactivated? ..................................... 63
   Deactivate Power Management in Windows XP ........................................ 64
   Deactivate Power Management in Windows 7 ............................................. 65
11 Known Problems and Remedies ............................................................... 68
   The horizontal spacing of icons on the desktop ........................................ 68
   Incorrect serial numbers with the NETZSCH F1/F3 instrument series ......... 69
      The ‘TASC 414/F1 SerialNumber’ tab ..................................................... 69
      The ‘Instrument Serial Number: INI-File’ section ................................. 70
      The ‘Instrument Serial Number: EEPROM’ section ............................... 71
   Problems with anti-virus programs .......................................................... 72
12 Adjust the Toolbar .................................................................................... 73
13 What Else Can Be Found on the CD-ROM .................................................. 74
1 General Information Regarding Software Installation

Summarized below is the procedure for installation or modification of your Proteus® Software.

Installation requirements

- Microsoft Windows XP Professional 32-bit / Windows 7 Professional 32/64-bit / Windows 7 Enterprise 32/64-bit / Windows 7 Ultimate 32/64-bit; together with
- Microsoft Internet Explorer
- [Local] Administrator Rights
- CD-ROM drive, with the possible addition of a diskette drive
- Subsequent permanent read/write access to C:\NETZSCH

Parts of the NETZSCH Proteus software require that the Microsoft .NET Framework Version 2.0 Redistributable Package (x86) and the Microsoft .NET Framework 4 Redistributable (x86_x64) to be installed. These can be downloaded for free from:


Please note the information there under System Requirements regarding Windows Installer.

OpenGL 2.0 or higher is necessary to display 3D-Graphics for a DMA242 and instruments with mass spectrometer coupling (Aeolos, Skimmer). Start the Windows Device-Manager to download a proper driver for your display adapter; right click with the mouse your display adapter and select 'Update Driver Software…'; please note that you need to have an active internet connection.

New installation

- All files required for execution of the program will be installed into the appropriate subdirectories of your hard drive.
- The files required for the Windows interface are automatically changed.
- The NETZSCH Proteus group folder is set up.

Update

- When an existing NETZSCH TA Proteus® software of the same generation is recognized, the following warning dialog is shown:
If you click the No button, the installation will continue and your previously carried out analysis- or measuring parameters will be replaced by the default values.

- All files required for execution of the program are installed into the existing subdirectories. Existing data, calibration, macro-recorder and sensitivity files remain unchanged.
- Configurations from the first installation are copied.

Modification

- In the individual menus, specific components are suggested for the instruments being installed.

Removal of Software

- NETZSCH Proteus® software can be removed manually.
- To remove it, it is necessary to have local administrator rights.
- If necessary, ask your system administrator for help.
- Double click the 'ServiceTools' icon within the 'NETZSCH-Proteus-6' group on the desktop.
- Select the tab labeled 'Helper Programs'.
- Select the 'ClearProteus' item within the 'Run a program' group, and then click the 'Run It' button.
- The 'Clear Proteus' program will be launched. The password needed is 'proteus' (without hyphens!).
- Click in the field labeled 'Password:'. Type in the password and click the 'AcceptPassword' button to confirm.
- Place a check-mark in each of the five left-most boxes as shown.
Confirm your settings by clicking the (now active) 'Do It' button. Repeat if necessary. Finally, click the 'Bye' button, which will automatically close the 'ClearProteus' dialog window.
Starting the “ServiceTools” program

Double click the following icon within the NETZSCH-Proteus-6 program group located on the desktop to start the “ServiceTools” program:

After ServiceTools is launched, go to the tab labeled ‘Helper Programs’.

Select ‘ClearProteus’ from the drop-down list and click the ‘Run It’ button to confirm.

Note:

A description of the ‘IconSpace’ program can be found in the chapter “The horizontal spacing of icons on the desktop” in this manual.
The 'ClearProteus' program will be launched, displaying the following dialog window:

Click in the field labeled 'Password:' and type in the password proteus1. Confirm by clicking the 'AcceptPassword' button. The dialog window should look similar to the following:
The Version (Generation) of the NETZSCH Proteus software is detected automatically. There is no reason to change the selection listed under Version (Generation) if you have only one Generation installed on your PC.
Place a check-mark in each of the five left-most boxes as shown. Click the 'Do it' button next. Follow the instructions should new dialog boxes appear.

If some of the settings you want to delete are not present (e.g. in the registry), a message box will pop up to inform you. In this case, the corresponding check-mark will be removed, but the rest of the check marks remain. Please repeat as necessary until all check-marks are removed automatically via the 'Do It' button.

Click the 'Bye' button to close this dialog.
Uninstalling the USB-COM driver for F1/F3 instruments

The USB-COM driver will only be installed by Windows XP Prof./ Windows 7 32/64-bit if you have an instrument of the NETZSCH F1/F3 series which is powered on and connected via a USB-cable to a PC on which the NETZSCH Proteus software has been installed.

You can manually uninstall the USB-COM driver for the instruments of the NETZSCH F1/F3 series from your PC. To do so, these steps must be followed:

Click the Windows ‘Start’ button and select ‘Settings->System Control’.

Double click the ‘System’ icon. Then click in the ‘System Properties’ dialog under the ‘Hardware’ tab and click the ‘Device-Manager’ button.

*Please note that Windows will only display noted entries mentioned in the ‘Device-Manager’ if your F1/F3 instrument is switched on and connected to your PC via a USB-cable!*

Expand the ‘Ports (COM and LPT)’ entry within the ‘Device-Manager’.

Select the ‘NETZSCH USB Port (COMx)’ entry with the left mouse button.

Then click the selected item with the right mouse button and select the menu item ‘Uninstall’.

Please follow the instructions in the dialog windows.

The port-driver will then be uninstalled.

Repeat the steps above for all USB connectors plugged into your F1 instrument; i.e. remove the USB cable from the USB connector at the PC end and plug it into the next USB connector to carry out the above-described uninstall procedure.

Scroll down in the dialog window of the ‘Device-Manager’ until you can see the entry ‘USB Controller’.

Expand this entry and continue scrolling down until the entry ‘NETZSCH USB Converter’ is visible.

Select this entry (‘NETZSCH USB Converter’) and click the right mouse button.

Choose ‘Uninstall’ from the menu.

Please follow the instructions in the dialog windows.

The USB driver will then be uninstalled.

Close the dialog window of the ‘Device Manager’. 
Now you are ready to remove the DLLs and INFs files. Please click the windows ‘Start’ button and open ‘Settings->System Control’. Find the icon labeled ‘Software’ and double-click it.

Find the entry ‘NETZSCH USB Drivers’, select it, and click the ‘Change/Remove’ button.

Follow the instructions in the dialog windows.

Remove the USB cable from the USB connector at the PC end.

Reboot your PC.
2 New Installation/Update: From CD-ROM

You have received the Proteus® software package for ‘Thermal Analysis’ on CD-ROM and one or more ‘supplemental floppy-disks’ (or a ‘supplemental CD-ROM’ or a ‘supplemental USB memory stick’) to activate the individual instrument software packages.

On the NETZSCH GENERIC CD-ROM, in the main directory, you can find the program ‘install.exe’ to install Proteus® software for TA measurements and standard analysis.

After installing the Proteus® software from the GENERIC CD-ROM, the TA software must be activated for each individual instrument.

For this, you will need the enclosed access disk(s) or the ADD_ONs CD-ROM.

You will also need the access disk(s) or the USB memory stick (ADD_ON) or the ADD_ONs CD-ROM for instrument-specific modifications.

The NETZSCH Proteus® installer

Close all applications and restart WINDOWS.

Insert the NETZSCH CD into the appropriate drive of your computer.

The ‘Auto-Start’ feature of your CD-ROM drive will be activated by default as long as your WINDOWS operating system was installed via standard-installation.

The operating system detects that a CD-ROM was inserted and starts the installation routine for the Proteus® Software automatically.
If the ‘AutoStart’ does not activate, manual installation must be carried out.

**Click** the Start button in the WINDOWS.

Type `e:\Install.exe` into the list box labeled ‘Search programs and files’ (replacing e: with the letter of your CD-ROM drive.)

**Hit Return to confirm!**

If the Windows Windows 7 Professional / Enterprise operating system is on your PC with default UAC (User Account Control) settings, then a dialog will be displayed asking permission to allow the program to run.

Click “Allow”

*I trust this program. I know where it’s from …*
The NETZSCH Proteus® installer dialog will open. The new installation is carried out in three steps:
- Base part (GENERIC) installation
- Instrument-specific unlock which can be on disk, memory stick or separate CD.
- Demo data installation

The installation order:
- Base part (GENERIC) installation
- Instrument-specific unlock is mandatory.

Please note: to avoid later problems with drivers, the NETZSCH Proteus® software must be installed before the PC is fitted with any IEEE interface card or connected to any USB cable.
The language chosen for this dialog ① remains active during the installation procedure.

Exception:
If you click the Finish button and re-start the NETZSCH Proteus® installer, this dialog comes up with the default language (English).

At ②, the current version number of the NETZSCH Proteus® software is displayed.

The ‘Base (GENERIC) part’ radio button is pre-marked in the ‘Select installation mode’ group ③ by default.

If you click the SysInfo button, some system information is displayed.

If you click the Continue> button, the selected installation mode is carried out.

If you click the help button, you’ll get additional information about NETZSCH Proteus installation.

If you click the Finish button, the NETZSCH Proteus® installer dialog will be closed.
Generic / base software installation

Please note that you must have administrator rights to carry out the NETZSCH Proteus® software installation.

The installation program will inform you about this. Please confirm this message by clicking the OK button.

Afterward, close the NETZSCH Proteus® installer by clicking the Finish button. Reboot your system and log in as administrator. Then restart the NETZSCH Proteus® installer.

If you don’t have an administrator password, please ask your system administrator for help.

The installation mode is already preset to install the base (GENERIC) part of the NETZSCH Proteus® software. By clicking the Continue button, the necessary directory trees will be generated, the basement files will be installed, and the parameters will be entered in the system’s registry.

Please follow the instruction messages after clicking the Continue > button.
The language selection for the rest of the installation appears once the installation routine for the NETZSCH Proteus® software has been started successfully, either by:

- the 'Auto-Start' feature of your CD-ROM drive (see above),

or

- manually (see above).

The program files (NETZSCH TA Proteus® software) must be installed onto the local hard drive of the computer on which the WINDOWS system files reside.

The measurement data files can be saved to any user-selected location.

Measurement and evaluation software need to be installed at the same time. The options are fixed and pre-set to 'active'.

The 'Basic Software Installation' of the Proteus® software must be selected for a successful installation.

If the 'Documents' option is selected, additional document files will be installed on the hard drive into the subdirectory

C:\Program Files (x86)\NETZSCH\Proteus61\docu
The installation will be continued as soon as you agree the license agreement.

Click ‘I Agree’.

The ‘Next >’ button will be activated.

Click ‘Next >’ to continue.
Instrument-specific unlock

After the ‘Base (GENERIC) part’ installation of the Proteus® software, the NETZSCH Proteus® installer dialog will be displayed again. The option ‘Instrument specific part’ is selected automatically.

Select the appropriate storage media type (disc, memory stick, separate CD) to continue the installation.

**ADD_ON**

**Memory stick**: Plug it in. It will be automatically recognized by the operating system.

**Separate CD**: Insert it into the CD/DVD drive when prompted.

Click on ‘Continue’ to go on with the procedure. If available, the next instrument can be installed by repeating the process.
To install multiple instruments, please use the following easy method:
The add-on parts are stored on the memory stick or on the separate CD.
Available instruments are listed in the left pane. By double-clicking them, or
by selecting them and then clicking on ‘→’, the various instruments to be
installed can be added to the selected list in the right pane. Then click ‘OK’ to
confirm the list in the right pane and begin the installation.

Enter the serial number of the instrument.

The serial number can be found on
the adhesive nameplate on the back
of the F1/F3 instrument.
Please note that the serial number is
comprised of at least 11 characters
(numbers and letters). The last
character in the serial number must be
a letter.

This dialog will be shown only when the
Setup.exe of the ADD_ON was launched via
double-click from within Explorer.

Example:

240-10-123-K

Before you plug in the USB-IEEE
Converter you must have installed
the appropriate KUSB 488 Driver
first. Please refer to the chapter
‘Installation of PCI and Other
Components’ in this manual.
Error messages: Reasons they appear, and what to do

If you try to activate one of the newer software versions of the basic installation with an access disk other than the one(s) delivered, an error message similar to the one shown here on the right will appear. To see more information about the reason for the error, click on the Info button. The installation procedure will be cancelled when you click on the OK button. Please note that you can only use the access disks provided for activating your Proteus® Software. We recommend deactivating anti-virus software during the NETZSCH-Proteus® installation.

Note: Please also refer to the section 'Problems with anti-virus programs.'
Installation of demo-data files

If desired, the user can install the sample files shipped by NETZSCH-Gerätebau GmbH for certain instrument(s).

This can be done by selecting the ‘Sample (DEMO) data files’ radio button and then clicking the Start button. The installation sequence of the demo files is menu-guided.

Click ‘Next >’ to start the sample (DEMO) data installation.
Click ‘Yes’ to continue.

Click ‘Next ’ to continue.

Complete the user name, and add your company name.
Change the setup type from ‘Complete’ to ‘Custom’ to get more control about the target directory and the files to be installed.

Click ‘Custom’ and after that click ‘Next >’.

Click ‘Browse…’ to select a different destination folder.

Click ‘Next >’ to continue.
In the ‘Directories:’ pane click the proper target directory.

If the proper target directory doesn’t exist, type in the full path in the ‘Path:’ edit box. This path will be generated automatically if it doesn’t exist already.

Confirm your input and click ‘OK’.

Select the checkbox(es) of the instruments that you would like to have Demo Data installed.

Click the ‘+’ in front of an instrument category to see the single components under of this category.

Tic all the components for that you would like to install demo data files.

Click ‘Next >’ to continue.
Click ‘Install’ to continue.

You will see this dialog if the installation of the demo data files was done.

Click ‘Finish’ to confirm this dialog.
If you need more demo data files installed, simply start the ‘Sample (Demo) data files’ installation again.

A dialog similar to this one shown here will be displayed.

Click ‘Next >’ to continue.

The already installed components will be recognized and ticked, together with the appropriate category.

You can tick now other categories and their components that you want to be installed.

Remove the tick on those components that you want to have un-installed.

Caveats:

If you remove the tick of a category then all components under this category become un-ticked.
If you tick the category again none of the components will be ticked automatically again!

Click ‘Next >’ to continue.
After a short period of time you will be informed the demo data files were added or removed.

Click ‘Finish’ to finalize the installation of demo data files.
Installation of the calibration files

The calibration curves can be automatically stored on the computer to be used when necessary.

**How to proceed:**
After complete installation of all instruments, click the ‘Calibration files’ radio button and select the storage media type on which the calibrations were delivered.

**Calibration from memory stick:**
Plug in the stick. After clicking ‘Continue’, the calibration data will be installed without any additional menu guidance.

**Calibration from CD-ROM:**
Insert the CD into the CD/DVD drive as requested. After clicking ‘Continue’, the calibration data files will be installed without any additional menu guidance. You will be able to access the calibration data via the Proteus® calibration menus.
Finishing the installation

Once the NETZSCH Proteus Software has been completely installed (i.e., GENERIC and all ADD-ONs) the NETZSCH Proteus® installer dialog can be closed by clicking the *Finish* button.

If the ADD-ONs were installed, the NETZSCH Proteus® installer will ask a final time for confirmation of automatic system reboot. This reboot is absolutely necessary and cannot be cancelled.

Please be patient at this point and do not interrupt the automatic system reboot. The rebooting time may last several minutes!

After the automatic system reboot, the NETZSCH icon will be displayed for the NETZSCH-Proteus group. The measurement and analysis sections of the NETZSCH Proteus software will be found here. They can be initiated by double-clicking on the appropriate icon.
After installing the first access disk (if you have more than one) you will see the NETZSCH-Proteus group among the program symbols in the Start menu and on the desktop.

Once the installation has completely finished, you can open the individual programs of the NETZSCH-Proteus group either via the Start-button in the WINDOWS taskbar, by selecting

All Programs>NETZSCH-Proteus-61>...

...or you can open the NETZSCH-Proteus-61 group from the desktop. Double-click on the program icon to start the appropriate program.
Start the analysis software.

Use File → Printer Setup… to adapt the settings for each of the six definition files to your hardware components. After selecting the menu point File → Printer Setup…, a dialog box similar to the one shown on the right appears. The current printer setting from the “system control” will be used automatically, as can be seen in the example shown on the right.

Select (as shown in the dialog box) the paper size, the paper orientation and the font type.

Select the proper decimal separator character for your printouts.
Going online for the first time with the measurement software

(Only F1/F3 instruments with 414/6 electronics; e.g. STA449F1/F3, DSC404F1/F3, etc.)

Before you start the measurement software, please make sure that:

- a sample carrier is plugged in,
- all furnaces are mounted and connected,
- external components (AUTOVAC, cooling, etc.) are connected.

When the measurement software has started, most of the connected components can be detected automatically.

Click the toolbar button labeled ‘Instrument Configuration’ or choose the menu item ‘Diagnosis->Instrument Configuration…’ to bring up the ‘Instrument Configuration’ dialog.

In the ‘Instrument Configuration’ dialog,

click the ‘Furnace Carrier…’ button.
Then click the ‘Furnace Carrier’ tab. (F1/F3 instruments only: STA449 F1/F3, DSC404 F1/F3).

Select the furnace carrier type which pertains to your instrument (one arm, two arms, or one arm with ASC).

Your selection will be highlighted with a red frame.

Next, click the ‘Connection of Furnaces’ tab.

Select the furnaces that are used with your instrument.

Please note:
Connect the left furnace with the left plug.
Connect the right furnace with the right plug.

If an external 2000°C furnace is connected and mounted on the ‘Furnace Carrier’, use drag and drop in the ‘Connection of Furnace’ tab to position the appropriate furnace figure on the proper side of the ‘Furnace Carrier’ symbol.
(This must only be done if the ‘real’ components were not correctly detected for some reason.)

Click the ‘Refresh’ button to ensure that the components were recognized.
All available sample carriers (of different types) must be mounted at least once to inform the system about their existence. Only then will the system list these sample carriers later in the measurement definition dialog.

Two options for how to do this procedure are described below.

Option 1.
Close the measurement software and plug the next sample carrier into the instrument.
Restart the measurement software. This will induce automatic recognition of the sample carrier currently installed. Repeat these steps for all of your different sample carrier types.

Option 2.
Start the measurement software and open the ‘Instrument Configuration’ dialog. Now ‘hot’ plug the next sample carrier into the instrument.
Click ‘Refresh’ in the ‘Instrument Configuration’ dialog to induce automatic recognition of this sample carrier. Repeat these steps for all of your different sample carrier types.
Click OK to close this dialog.
3 PDF Documents in the Measurement Software

During installation of the ADD_ON part of the NETZSCH Proteus software, several document files in PDF format were installed. Depending on the instrument installed, various files relating to the instrument can be found via the Help menu in the measurement software.

To view and print out these documents, you need a PDF-capable program such as Acrobat Reader.

If you do not have Acrobat Reader installed on your computer, you can download this free software from:

www.adobe.com/go/downloads
4 Automatic Installation of a PDF Printer

After installing the Proteus® software, an additional printer called 'NovaPDF Pro' will appear in your WINDOWS Control Panel. This is automatically installed with any NETZSCH Proteus® software from the fifth generation onward, and serves to create tables, results and graphics in PDF format directly within the Proteus® Analysis software.

The use of this printer within Proteus® Analysis is automatically licensed upon purchase of the fifth-generation Proteus® software. For other purposes, such as in your word processor, it is necessary to purchase and license the product from the manufacturer. Except within the fifth-generation NETZSCH Proteus® software, all other PDF files created using this printer will carry a watermark in the footnote which reads, "Create PDF files without this message by purchasing NovaPDF printer (http://www.novapdf.com)", to remind you that this printer must be purchased and licensed by the manufacturer for any external purposes.

Note:
Do not uninstall the NovaPDF Pro printer, since you will then not be able to print in PDF format within NETZSCH Proteus® Evaluation.
If the program is unintentionally uninstalled, it can be restored by simply reinstalling the NETZSCH Proteus software.
5 Installation of PCI and Other Components

For NETZSCH instruments equipped with a TASC 414/2, TASC 414/3 or TASC 414/4, you must install the PCI-IEEE488 card and the appropriate driver.

Installation of the PCI-IEEE488 card (only under Windows XP Prof.)

The PCI card is the technological successor to the ISA card. It requires at least one free PCI slot in the computer. The PCI card cannot be used in an ISA slot, and an ISA card cannot be used in a PCI slot.

Procedure:

1. The NETZSCH Proteus® software here requires the WINDOWS XP Professional operating system.
2. **DO NOT INSERT THE PCI CARD** before NETZSCH Proteus® is installed!
3. Shut down and reboot the computer.
4. We recommend checking the ‘Plug and Play’ option to ensure that ‘PnP’ = ‘NO’ in the BIOS before installing the software. PCI card installation will fail if ‘PnP’ = YES. Please enter the BIOS-Setup during start-up of the computer to check this. The start screen before the WINDOWS desktop appears will guide you on how to enter. For most computers, soft key F2 grants access.

   ![Example for AMIBIOS - how to set PnP to NO](image)

5. Install the **NETZSCH Proteus software first**, which includes the PCI card driver CEC488.INF. To do this under **XP Professional**, it is necessary to login as **local administrator**, i.e. you need to login as "Administrator" with the password for the administrator. If this procedure is unknown to you, please contact the **system administrator** for your computer system.
6. After complete installation, switch off the computer. Insert the PCI card.
7. After booting, the **WINDOWS Hardware Wizard** will detect the new PCI hardware and ask for the new PCI-GP488 driver. The option ‘**Select a driver from list**’ is
absolutely necessary to ensure correct installation!

8. The hardware wizard now asks for the location of the driver. The correct driver is automatically found as CEC488.INF in the root folder of the WINDOWS directory of the system (C:\WINDOWS\System32).

9. After confirming with ‘OK’, the plug and play procedure starts. The PCI driver is added to the WINDOWS driver list as a new device. This can be checked under WINDOWS\System control\device manager. Connect the instrument with TASC 414/2/3 or /4 to the computer and switch it on. Start the measurement part of the NETZSCH Proteus® software. The status line must indicate ‘ON’. If this is not displayed, check with ServiceTools. Close the measurement and start ServiceTools to ‘Scan’.

This lists all IEEE-devices found connected to the computer with addresses 18…21.

Please note that the ‘hardware wizard’ was renamed by Microsoft as ‘Device Manager’ in Windows XP Professional. During the installation of the device driver from within the ‘Device Manager’ (which starts automatically) of either operating system, you simply have to select the core directory (e.g. WINDOWS\System32).

As a hidden file, the CEC488.INF can be found manually with special Explorer settings. Start Explorer and select Options from the Tools menu. Disable the option ‘Hide file extensions for known file types’.

![Software Installation Manual](image-url)
Check if the resources for the IEEE488-PCI board are displayed without an error message by using the Device Manager of Windows XP Professional.

To open the WIN XP Professional Device Manager, hold down the Windows key and hit the “Brk” key simultaneously. Select the Hardware tab in the Device Manager’s dialog.

Find the CEC… device, right-click and select Properties.

Finally, click the resources tab within the properties dialog of the CEC… device and check that there is no error message. The resources and addresses shown are only examples and may differ from those shown in your own system.
Installation of the USB-IEEE converter for connection to USB port of the PC (under Windows XP Professional)

Installation conditions

The Proteus software can be installed on any PC with WINDOWS XP Professional – provided that the WINDOWS installer is Version 2.0 or higher.

For update installations to existing customers’ “older” PCs, please keep in mind that that these conditions may not be fulfilled for Windows XP Professional under Service Pack 1. Windows XP Professional PCs with Service Pack 3 (the latest) have a suitable Windows installer (currently Version 3.1).

If an error message appears during the demonstration of the Proteus Basis CD-ROM saying that the file IEEE_32m.DLL cannot be installed, a suitable Windows installer – or better yet, a current Service Pack – must be installed on the PC. This file is also required for instruments operating without an IEEE communication, i.e. F1/F3 and PC instruments.

At a minimum, the following versions of the Windows installer can be downloaded and installed after searching for “windows installer download” on the Microsoft Support Pages (http://microsoft.com):

- WINDOWS XP Professional requires Windows Installer 3.1

The necessary Windows installers should be installed in the same language as the operating system. These cannot be provided by NETZSCH due to licensing restrictions – and also because of the different language versions of Windows. Please ask for help from the local network administrator on site.

Procedure:

1. The NETZSCH Proteus® software requires the XP Professional operating system.
2. DO NOT CONNECT ANY USB CABLE before NETZSCH Proteus® is installed!
3. Shut down and reboot the computer.
4. Install the NETZSCH Proteus software first.
5. Select the radio button ‘USB-IEEE 488 Driver’ in the ‘NETZSCH Proteus Installer’ dialog and click ‘Continue >’. Follow the instructions seen in the dialogs.

To do this under XP Professional, it is necessary to login as local administrator, i.e. you need to login as "Administrator" with the password for the administrator. If this
procedure is unknown to you, please contact the "system administrator" for your computer system.

6. After complete installation, connect the USB-IEEE converter cable to a USB connector on your PC.

7. Next, the WINDOWS Hardware Wizard will detect the new USB-IEEE hardware and ask for the new USB-GP488 driver. The option ‘Select a driver from list’ is absolutely necessary to ensure correct installation!

8. The hardware wizard now asks for the location of the driver. The correct driver is automatically found as gpib488.INF in the root folder of the directory of the system (C:\WINDOWS\System32 for WINDOWS XP).

9. After confirmation with ‘OK’, the plug and play procedure starts. The USB-IEEE-driver is added to the WINDOWS driver list as new device. This can be checked under WINDOWS\System control\device manager.

Connect the instrument with TASC 414/2/3 or /4 to the computer and switch it on. Start the measurement part of the NETZSCH Proteus® software. The status line must indicate ‘ON’. If this is not displayed, check with ServiceTools. Close the measurement and start ServiceTools to ‘Scan’. This lists all IEEE-devices found connected to the computer with addresses 18…21.

During the installation of the device driver from within the ‘Hardware Wizard’ (which starts automatically), you must select the directory (WINDOWS\System32).

As a hidden file, the gpib488.INF can be found manually with special Explorer settings. Start Explorer and select Options from the Tools menu. Disable the option ‘Hide file extensions for known file types’.
Check if the resources for the GPIB-interface are displayed without an error message by using the Device Manager of Windows XP Professional. To open the WIN XP Professional Device Manager, hold down the Windows key and hit the “Brk” key simultaneously.

Select the Hardware tab in the Device Manager’s dialog.

Find the CEC… device, right-click and select Properties.

Check that there is no error message.
Installation of the USB-IEEE converter for connection to USB port of the PC (under Windows 7 Professional 32/64-bit)

1. Make sure that your PC has no PCI-IEEE card built in; remove the PCI-IEEE card before you continue here.

2. Please note that the NETZSCH Proteus® software must be installed before you plug in the USB-IEEE converter to your PC.


Click ‘Continue >’. 
4. Select the radio button that fits to your hardware.

Click ‘Install’ to carry out the driver installation.

5. Plug in the USB-IEEE converter to the USB port of your PC. The following information will be displayed in the taskbar.

6. After a short period of time, the following dialog will be displayed:

7. Click the ‘Close’ button to confirm this dialog.
Some notes on how to use the USB-IEEE converter

To maintain error-free operation, make sure that only one USB-IEEE converter is connected to each PC – remove any other existing IEEE cards from the PC.

If several TASCs 414/4 with different addresses must be connected to one PC, use the attached IEEE connection cables. These cables must then be jointly connected to the PC via one USB-IEEE converter.
Troubleshooting KUSB 488-Driver

1. KUSB 488A-Treiber was installed additionally over KUSB 488B

The KUSB 488B-driver was correctly installed and the communication between PC and TASC 414/2/3/4 was working properly. By mistake the KUSB 488A-driver was installed additionally. This can easily happen because the former KUSB 488A-driver installation from 2006 was not aware of the future KUSB 488B and so this situation could not be prevented.

The former Proteus 4.x or 5.x Generic installations do install the KUSB 488A driver under compulsion! So this additional installation destroys a KUSB 488B installation of a new Proteus Software from version 6.1 which was functional before. Communication between PC and TASC 414/2/3/4 is not working anymore. In the worst case the analyzing software crashes.

After identification of this problem the KUSB 488A drivers must be uninstalled via the system control, the PC must be booted and then the new KUSB 488B driver from the Proteus CD (as of version 6.1 Aug 2013) must be installed as it was described before.

2. Wrong driver installed

The driver installation will fail and be marked with an exclamation mark on a yellow background in the device manager when by accident the wrong driver (KUSB 488A) was installed and then the KUSB 488B was connected:

As described before first uninstall the wrong driver via the Windows System Control, and boot the PC. Finally the KUSB 488B driver can be installed from the new Proteus CD (as of version 6.1 Aug 2013) hereby the KUSB 488B hardware must be not yet plugged in.

KUSB 488-Driver uninstallation

The wrong KUSB can be identified and uninstalled in the system control:
For Windows XP ➔ system control/software …
For Windows 7 ➔ system control/programs and functions …

Wrong drivers may not be uninstalled in the Windows Device Manager!
IEEE driver from a KUSB 488A 1.400.60-09.2.00 resp. 1.400.60-09.4.00 under WIN 7

Please note that for this driver no version, no size, and no vendor will be displayed. The version will be displayed in a sub-following dialog if you click ‘Uninstall/Change’.

Version of a KUSB 488A driver 1.400.60-09.2.00 resp. 1.400.60-09.4.00 under WIN 7

IEEE driver from a KUSB 488B 1.400.60-09.5.00 resp. 1.400.60-09.5.00 under WIN 7

IEEE driver from a PCI board 1.400.60-07 under WIN XP

Please consider this information during the installation of the KUSB 488 drivers resp. for the troubleshooting of failures.
Installation of the USB-COM converter for F1/F3 instruments and DIL 402 PC with USB interface (under Windows 7 Prof. 32/64-bit/ Windows 7 Enterprise 32/64-bit/ Windows 7 Ultimate 32/64-bit)

Beginning with Proteus® Version 5.2.0, certified drivers will be pre-installed for ‘NETZSCH USB Converter’ and ‘NETZSCH USB Port’ together with the Proteus® GENERIC installation. This induces automatic installation of the proper driver when an instrument is connected with the PC via USB cable. No user intervention is needed.

Plug the instrument into the PC via USB cable after the Proteus® software installation ( GENERIC, ADD_ONs ) has been completed successfully.

**Note:**

- Do not connect the USB cable from the instrument to your PC before you have installed the Proteus® software, because the driver files will be copied to your hard disk and are available there only after the Proteus® software installation.

- Do not use external USB hubs to connect the F1/F3 instrument or the DIL 402 PC to your PC.

- For existing instruments of the F1/F3 series and DIL402PC which have been run on Proteus software older than Version 5.2.0 until now, see the chapter **Driver update for instruments of the F1/F3 series and DIL402PC.**
6 Customize the Installation

If you would like to adapt previously installed software, you will need the appropriate floppy disk for your software package (the ADD_ON or Access disk) or the ADD_ONs CD-ROM.

- When adapting the software, please be sure that the changed setup information fits to the specific instrument configuration.
- During execution of the setup program, you will have the option of adding more components under various menus.
- Components that are already installed are always highlighted in blue. New components can be added by clicking on those not highlighted blue.
- Components can be removed by clicking on a component highlighted in blue. All remaining highlighted components will be installed.
- Click OK to accept the changed configuration as displayed.
- Cancel reverses all changes made to the settings.
- Please observe the notes in the ‘Set-up’ chapter of your software manual when adapting instrument-specific components (furnace, sample carrier, crucibles, etc.)
Start the NETZSCH Proteus® installer from your CD-ROM as described in the new installation section, mark the radio button ‘Instrument specific unlock (ADD-ON) part’ and then click the Start button. If no separate ADD_ON diskettes are shipped, please select only a single ADD_ON for which you want to do a customization in the multi-installation ‘Select ADD_ON instrument software packages’ dialog.

Select the Option

"Customize Current Installation".

Follow the dialog boxes to adapt your existing software to the various requirements described below.

Interface Address

Via its system address, please choose the TASC controller which you want to adapt. The ‘Interface Address’ point under the ‘Category:' heading shows a list of the TASC controllers already installed. In the 1st column, either the number of the TASC controller interface (e.g. 18) or the number of the F1/F3-instrument is displayed; the 2nd column shows the type of TASC controller (e.g. TASC 414/4); and finally the 3rd column shows the name of the TASC controller interface used.
Adding more channels

Under ‘Category’, select the topic ‘Tasc Controller’ and then in the ‘Tasc Controllers List’ select the type of TASC controller for which you want to add a channel.

Please make sure the ‘Add’ button in the ‘Channels’ group is disabled.

Adding more channels

Under ‘Category’, select the topic ‘Tasc Interface’ and then in the ‘Tasc Controller Interfaces List’ select the type of TASC controller interface for the TASC controller type you selected in step 1.

Adding more channels

If you select the TASC controller interface, the list of supported channels will be displayed.

Please note that the ‘Add’ button in the ‘Channels’ group is now active.

Clicking the ‘Add’ button selects your previous settings.

Note:
Please note that the ‘Remove’ button in the ‘Channels’ group will be enabled as soon as ‘Interface Address’ is selected in the ‘Category,’ list. Clicking the ‘Remove’ button at that point will delete the highlighted channel from the list of currently installed channels.
Adding more channels

When the ‘Add’ button is clicked, another dialog is displayed. Here you can type in the number of the interface you want to add. Click OK to confirm.

If the highlighted number in this dialog fits, clicking OK is all you need to do.

Note:
- For the TASC 414/3/4, “Channels” means the interface address
- For the TASC 414/5-PC, “Channels” means the COM interface number
- For the TASC 414/F1/F3, “Channels” means the number of the installed instrument, e.g.:
  1. DSC204 F1 instrument on PC
  2. DSC204 F1 instrument on PC
  and so on

Adding more channels

A maximum of four independent TASC controllers can communicate with one computer.
The manufacturer sets each of the TASC controllers with an IEEE interface to a channel between 18 and 21.

Please check that your settings have been transferred correctly. To do so, select ‘Interface Address’ in the ‘Category’ list.

You will see one more channel added with your presets. This channel and its settings will become active in your system when you click OK in the 'Instrument Setup' dialog. The settings are then saved on your hard disk.
**Enter the serial number of the instrument.**

This dialog will be displayed only for F1/F3 instruments.

The serial number can be found on the adhesive nameplate on the back of the F1/F3 instrument.

Please note that the serial number is comprised of at least **11 characters** (numbers and letters). The last character in the serial number must be a letter.

You will be asked for the serial number of every F1/F3 instrument you added with ‘Customize’.

**Example:**

240-10-123-K

**External balance**

For any instrument requiring input of the sample weight, it can be entered via an external balance.

NETZSCH offers an external balance (order no. 6.220.10-99.1) that can be connected to serial interface RS 232. The sample weight is entered directly into the measurement parameter input.

If your instrument is equipped with an external balance, activate this option by clicking the control box.
External Length Caliper

For any instrument requiring input of the sample length, it can be entered automatically via an external digital caliper gauge.

NETZSCH offers an external digital caliper gauge (order no. 6.219.1-95.1) that can be connected to serial interface RS 232. The sample length is entered directly into the measurement parameter input.

If your instrument is equipped with an external digital caliper gauge, activate this option by clicking the control box.

Analog Channels

Any changes to this setting would only be required after first checking with NETZSCH-Gerätebau GmbH.

Furnaces

A list of all furnaces available for the selected instrument appears in the ‘Category Settings: Furnaces’ window.

Install the furnace(s) that correspond to your instrument configuration.

Please note the comments in the ‘measurement’ (instrument setup) section as well.

¹) Not applicable for instruments with 414/6 electronics. The appropriate components will be detected automatically.
Sample carriers

A list of all sample carriers available for the selected instrument appears in the ‘Category Settings: Sample Carriers’ window.

Install the sample carrier(s) that correspond to your instrument configuration.

Please note the comments in the ‘measurement’ (instrument setup) section as well.

Crucibles

A list of all crucibles available for the selected instrument appears in the ‘Category Settings: Crucibles’ window.

Install the crucible(s) that correspond to your application.

Please note the comments in the ‘measurement’ (instrument setup) section as well.

*) Not applicable for instruments with 414/6 electronics. The appropriate components will be detected automatically.
The technical data listed under the categories ‘Furnace’ and ‘Sample carrier’ is provided only for the information of the user.  

Devices *)

Under ‘Devices’, external accessories (cooling, gas purge, vacuum, etc.) can be adjusted.

The presetting under the ‘Instruments’ heading depends on the respective instrument model.

Activate the required option(s) by clicking.

*) Not applicable for instruments with 414/6 electronics. The appropriate components will be detected automatically.
TC Recalibration

Under the heading ‘TC Recalib’, the thermocouple recalibration limit can be adjusted.

The presetting under the ‘TC Recalib’ heading depends on the respective instrument model.

Activate the required option by clicking.

The instrument settings define the maximum temperature range for the input and therefore allow for only a restricted test of faulty inputs.

If a customer-specific component is selected, it does not go into the maximum temperature test!
7 Upgrade to NETZSCH TA Proteus® Software

The NETZSCH Proteus® software was designed as a pure 32-bit application in accordance with the standard for Windows XP Professional/Windows 7 Professional/Windows 7 Enterprise. This includes support of the right mouse button, tool bars and multi-user configuration.

The moveable toolbars allow very fast access to dialogs and calculation routines. The toolbars can be freely displayed or hidden by the user.

The toolbar for drawing-objects allows the generation of text, rectangle, ellipses, and other simple graphics. This assists the user in generating sophisticated presentations of analysis results.

Long file names for loading and saving measurement results are supported.

Up to 64 files can be loaded, displayed and analyzed simultaneously.

In order to see what you are loading prior to actually loading it, a file preview and a curve preview have now been implemented in the open-file dialog.

The curve preview mode allows very fast selection between different data files using the arrow keys on the keyboard. The connected curve preview displays the curve shape of the most recently selected data file rapidly and without any delay.

A print preview for graphics and tabulated data has now been implemented so you can see what you will get, prior to printing.

If you have to stop analyzing a measurement for some reason before you've finished, it is possible to save the current state of analysis via the ‘Save State As...’ menu option and reload it later via ‘Restore State From...’ to continue.

The file extension is ‘*.NGB-TAA’, because all analysis steps and all object properties and data are saved here. The current program version thus allows for a fast and complete regeneration of any analysis state.

To see more details in the curve shape, zoom functionality was improved. It is now possible to increase any point of the curve continuously. There is an undo function which allows jumping back the last zoom. Switching back from detailed view to full scale is possible via one mouse click on the appropriate toolbar button.

All properties for analysis results, curves, and axes can be displayed and changed by selecting the object and clicking the right mouse button. Some examples of properties are text font, text size, text color, underscoring, line type, reference line, smoothing factor, and start of a calculation on the selected object.
Upgrade of DMA 242 16-bit to Proteus® 6.x

- Only measurement files carried out with a DMA 242 16-bit version newer than November 1999 can be opened with Proteus® DMA 242 analysis.
- Proteus® DMA 242 measurement does not allow the opening of 16-bit measurement files.
- Proteus® DMA 242 measurement can use 16-bit system stiffness calibration files.

Upgrade of NETZSCH DSC200, TG209 16-bit 2nd generation to Proteus® 6.x

- Existing 2nd generation (16-bit WINDOWS 3.0/3.11 operating system) measurement files cannot be opened with Proteus®, either in measurement or in analysis.

Upgrade of NETZSCH series 200/400 16-bit 3rd generation to Proteus® 6.x

- Existing 16-bit, 3rd generation measurement files can be opened with Proteus® analysis.
- Parameters and temperature program of 16-bit, 3rd generation measurement files cannot be used to prepare new Proteus® measurements.
- Baseline runs of 3rd generation measurement files cannot be used to create new Proteus® combined sample + correction measurements.
- Existing 3rd generation calibration files can be converted (via “Open” and “Save As”) for use in Proteus® measurements.

Upgrade of NETZSCH series 200/400 4th / 5th generation to Proteus® 6.x

- Existing Proteus, 4th/5th generation measurement files can be opened with Proteus® analysis.
- Proteus, 4th / 5th generation measurement files cannot be used to prepare new Proteus® measurements.
- Baseline runs of 4th / 5th generation measurement files cannot be used to create new Proteus® combined sample + correction measurements.
- Existing 4th / 5th generation calibration files can be converted (via “Open” and “Save As”) for use in Proteus® measurements.

Upgrade of DOS to Proteus® 6.x

- Measurement files cannot be opened with Proteus® 6.x.
- DOS exported ASCII measurement files can be ASCII-imported to Proteus® analysis.
8  USB-COM Driver Update for the Instruments of the F1/F3 Series and DIL402PC

As of Proteus® software Version 5.2.0, certified drivers of the USB-interface are used for the instruments DSC 204 F1, TG 209 F1, DSC 200 F3, TG 209 F3, STA 449 F1, STA 449 F3, DSC 404 F1, DSC 404 F3 and DIL 402 PC.

If a Proteus® software version older than Version 5.2.0 was used for the above-mentioned instruments, the built in USB-modules must be re-programmed so that they will be recognized and used by the certified drivers.

This procedure is done in several steps:

1. Re-programming the USB-module of the instrument just connected; this is done automatically by the Proteus measurement software.

2. Activating the pre-installed (certified) driver of the USB-interface; this is done automatically by the Proteus measurement software.

3. Downloading the current firmware to the microcontroller of the instrument; the program SystemFlasher or ServiceTools must be started manually for this download.

Note:
Step 3 refreshes the firmware in the microcontroller of the instrument and is mentioned here only for the sake of completeness; the update of the USB-COM driver itself is not hereby affected.
9 SystemFlasher

The SystemFlasher automatically updates the firmware (of a TASC 414/6 main unit processor), the PICware (of the board processors), the macroware (of the TFT display) and the instrument/furnace EEPROMs.

Start of the SystemFlasher

Open the ‘NETZSCH-Proteus’ program group on the desktop and double click the ‘System-Flasher’ icon.

The following dialog will then be displayed.

Click OK to start scanning COM 1…16 for connected instruments with TASC 414/6 electronics.

The instruments with 414/6 electronics found will be listed, and the download will start automatically if the version numbers of the firmware/PICware/macroware of these instruments
are ‘older’ than the appropriate current versions on the hard disk.

After a successful download of the firmware (which will last several minutes), the PICware will be refreshed and finally the TASC 414/6 electronics will be re-started.

In the next step, the contents of the instrument and furnace EEPROMs will be refreshed (if necessary).

In the last step, the TFT display macroware will be downloaded.

The download procedure for the TFT macroware lasts about 20 minutes.

The download/update steps will be logged and displayed.

The entire procedure lasts 30 to 40 minutes for each instrument.
The following dialog is shown when the entire procedure is finished for all instruments.

![Information dialog](image)

Clicking OK closes this dialog and automatically also the SystemFlasher dialog.

**In case of error messages**

If error messages are displayed during one of the above-mentioned download steps, the SystemFlasher must be closed and re-started to repeat the erroneous step.

Note:
Confirm the error messages but wait until the ‘Information’ dialog states ‘Procedures finished’ before you close and re-start the SystemFlasher.

On a second start of the SystemFlasher, the steps already done successfully will be skipped and therefore will not be carried out a second time.
10 Power Management

What is Power Management?

Power Management is the tool within the operating system for saving electrical energy by switching some hardware components, e.g. CPU, hard disk, and screen, to standby mode and reactivating them automatically when needed by the user.

Why deactivate Power Management?

To guarantee a smooth operation of the NETZSCH Proteus measurement software under the Windows XP Professional/Windows 7 Professional/Windows 7 Enterprise operating systems, Power Management must be deactivated both in the BIOS of the computer and in the Windows System Control.

What does NETZSCH-Gerätebau recommend?

We strongly recommend disabling the Power Management under Windows XP Professional/Windows 7 Professional/Windows 7 Enterprise! Deactivating the Hard Disk Power Management is especially critical.

How can the Power Management be deactivated?

Most computers allow you to disable Power Management features using the BIOS Set-up tool. Pressing certain keys after turning the computer on can usually start the BIOS Set-up tool. Use the F2 key on a HEWLETT PACKARD with Phoenix BIOS. For other computer models, consult your computer’s documentation or manufacturer for specific instructions. You may also need a password.

On a HEWLETT PACKARD, select the menu item ‘Power’ in the PhoenixBIOS Set-up Utility by using the arrow keys on your keyboard. Make sure that both of the following settings are disabled:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standby Delay</td>
<td>[None]</td>
</tr>
<tr>
<td>Suspend Delay</td>
<td>[None]</td>
</tr>
<tr>
<td>(set to None).</td>
<td></td>
</tr>
</tbody>
</table>
Deactivate Power Management in Windows XP

Double-click the item 'Power Options' in the Windows Control Panel.

Select the Power Options Properties window.

Select the settings shown in the figure above!

- Turn off monitor: After 30 min.
- Turn off hard disks: Never
- System standby: Never
- System hibernates: Never

Systems other than HEWLETT PACKARD have Power Management in a similar form, which also has to be disabled to guarantee faultless operation with NETZSCH Proteus software.
Deactivate Power Management in Windows 7

Click the Windows "Start" button and select "Control Panel".

Click "Hardware and Sound" on the left.

Click "Power Options" on the right.
Select "High performance" and click "Change plan settings" located below "High performance".

Click "Change advanced power settings".
Make sure that the conditions listed below are set in this dialog:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Setting Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hard disk</td>
<td>Never</td>
</tr>
<tr>
<td>Turn off hard disk after</td>
<td>Never</td>
</tr>
<tr>
<td>Sleep</td>
<td>Never</td>
</tr>
<tr>
<td>Sleep after</td>
<td>Never</td>
</tr>
<tr>
<td>Hibernate after</td>
<td>Never</td>
</tr>
<tr>
<td>USB settings</td>
<td>Disabled</td>
</tr>
<tr>
<td>USB selective suspend setting</td>
<td>Disabled</td>
</tr>
<tr>
<td>Processor power management</td>
<td></td>
</tr>
<tr>
<td>Minimum processor state</td>
<td>100%</td>
</tr>
<tr>
<td>Maximum processor state</td>
<td>100%</td>
</tr>
</tbody>
</table>

Click the "Apply" and "OK" buttons to confirm the new settings.
11 Known Problems and Remedies

The horizontal spacing of icons on the desktop

Depending on your settings, the horizontal spacing between icons on the desktop may be inadequate. Long text will be cut off in this case and an ellipsis (…) will appear.

Remedy

Please use the program ‘IconSpace.exe’ which can be found on the tab ‘Helper Programs’ in ServiceTools.

Type a larger value into the ‘New distance:’ box than the value displayed after ‘Distance found:’. If you want to restore your original settings, note this value for later use! Click the ‘Bye’ button to leave the program.

If you do not see changes in the distance of the desktop icons you can use the tool ‘Refresh Windows IconCache’ from the tab ‘Helper Programs’ in ServiceTools.
Incorrect serial numbers with the NETZSCH F1/F3 instrument series

Before the internal program structures are initialized and the ‘On’ information can be displayed in the status line, the NETZSCH Proteus® measurement program checks for the correct serial number to see if a NETZSCH F1/F3 series instrument is connected to the PC.

The NETZSCH Proteus® measurement can only be started correctly when the serial number typed in by the user during the ADD-ON installation matches the serial number found in the instrument EEPROM of the F1/F3 instrument connected to the PC.

Double-click the ‘ServiceTools’ icon within the ‘NETZSCH–Proteus’ group on the desktop to start ‘ServiceTools’.

**The ‘TASC 414/F1 SerialNumber’ tab**

For this tab, a password is needed.

![Password dialog box](image)

After typing in the correct password, the following layout is displayed. Please contact NETZSCH-Gerätebau GmbH (Tel.: +49/(0)9287/881-555, email: AT@NETZSCH.COM) to get the password.
The ‘TASC 414/F1 SerialNumber’ window is divided into two sections. The first section is labeled ‘Instrument Serial Number: INI-File’, and the second section is labeled ‘Instrument Serial Number: EEPROM’.

The items in the ‘Instrument Serial Number: INI-File’ section handle the interchange of the serial number with the appropriate INI-files found installed on the hard disk.

The items in the ‘Instrument Serial Number: EEPROM’ section handle the interchange of the serial number with the instrument EEPROM.

**The ‘Instrument Serial Number: INI-File’ section**

In the example above, the TG 209 F1 Libra instrument (instrument ID = 55) was found installed at serial interface COM4. This can be seen according to the path displayed in the ‘Found INI – Files:’ combo box: ‘C:\NETZSCH\Proteus 6\Program\55_1.ini’. The name of the ini-file 55_1.ini first shows the instrument ID (55) and secondly – after the underscore – the counting number of the installed instrument (1 = the 1st installed instrument of this type).

The serial number ‘1111111111111111111A’ found in the INI-file is displayed in the box labeled ‘Serial Number:’. Please note that the number displayed in this example is not a real serial number.

If no proper INI-file could be found on the hard disk for the selected F1-instrument, then the ‘Found INI – Files:’ combo box is left blank.

Please note that the serial number displayed the ‘Serial Number:’ is not updated in this case (but it would be updated if a proper INI-file were found).

The serial number in the ‘Serial Number:’ box can be edited by clicking the ‘Modify Serial Number’ check-box in the ‘Instrument Serial Number: INI-File’ section.

After changing the serial number, the user can click the ‘WriteSerialNumberToFile’ button. The changed serial number will then be written into the file displayed in the ‘Found INI – Files:’ drop-down list.
Note:
Changing the serial number here and writing it back into the INI-file of the installed instrument is not necessary under normal conditions, because during the ADD_ON installation of any F1/F3-instrument, the user is asked for a proper serial number. The serial number typed in by the user during the ADD-ON installation of a F1/F3 instrument is written to the appropriate INI-file on the hard disk of the target system.

The ‘Instrument Serial Number: EEPROM’ section

The ‘Instrument Serial Number: EEPROM’ section consists of the ‘Interface Address:’ drop-down list, the ‘Connect’ button, the ‘Options…’ button, the ‘connection state’ LED, the ‘Serial Number:’ field, the ‘Modify Serial Number’ check-box, the ‘ReadSerialNumberFromEEPROM’ button and the ‘WriteSerialNumberToEEPROM’ button.

To read a serial number from the instrument EEPROM or to write any serial number into the instrument EEPROM, the user has to select the serial interface number at which the F1/F3 instrument is connected from the ‘Interface Address:’ drop-down list.

Before anything can read from or be written to the instrument EEPROM, the user must click the ‘Connect’ button.

If the connection to the instrument EEPROM was successful, the color of the ‘connection state’ LED is changed from gray to green to show that the connection to the instrument has been established. Additionally, the caption of the button changes from ‘Connect’ to ‘Disconnect’.

Clicking the ‘ReadSerialNumberFromEEPROM’ button displays the serial number read in from the instrument EEPROM in the ‘Serial Number:’ field.

By check-marking the ‘Modify Serial Number’ box, the ‘Serial Number:’ field will change from read-only to write. The user can now change the serial number and write it back to the instrument EEPROM by clicking the ‘WriteSerialNumberToEEPROM’ button.

Please note that only the default settings for the serial interface can be activated when clicking the ‘Options…’ button. The default settings are: 19200 baud, 8 data bits, 1 stop bit, no parity, CRLF will be added automatically as delimiter for every string sent out.
Problems with anti-virus programs

It is possible that an active anti-virus program may cause problems during the ADD_ON installation of NETZSCH Proteus®.

In such a case, the installation will display a message box and the installation will abort. The text in the message box will indicate that the product version number could not be determined.

Remedies:

1. Switch off the anti-virus program temporarily. Ask your system administrator for assistance. Try to install the ADD_ON diskette again.

   (If it is not possible to switch off the anti-virus program temporarily, or the installation fails even though the anti-virus program is switched off, then continue with step 2.)

2. Copy the content of the ADD_ON diskette to a temporary sub-directory on the hard disk of your PC and start the ‘setup.exe’ from there.

   (If step 1 and step 2 both fail, then continue with step 3.)

3. Use the ‘Clear Proteus’ program (located on the ‘Helper Programs’ tab in ServiceTools) to remove all entries in the sub-directories C:\NETZSCH\Proteus61\program and C:\Program Files (x86)\NETZSCH\Proteus61\program and the appropriate entries in the registry as well. Then reboot your system and start again, re-installing the ‘GENERIC’ and ‘ADD_ON’ parts of NETZSCH Proteus®.
12 Adjust the Toolbar

Open the analysis software by double-clicking on:

You can arrange the toolbar components to suit your own preferences.

Click one of the toolbar sections which you wish to move to a free area.
Keep the left mouse button pressed while moving the mouse to the desired destination (drag).
Release the left mouse button. The moved toolbar section is now docked to the new position.

Your new toolbar settings are saved this way when the analysis software is closed.
13 What Else Can Be Found on the CD-ROM

The Service sub-directory contains software diagnosis tools for service purposes for some TASC-controller types. Please see the Readme.txt file there for more instructions.

The NETZSCH Proteus® installer uses the Demo data and Generic sub-directories during installation.

The NETZSCH Proteus® installer can be found as a file with the name install.exe contained in the root directory of the CD-ROM and can be started from there.